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Preface

Welcome to Oracle Reports Developer! This document will help you get started 
with Reports Developer for Windows.

Prerequisites
You should be familiar with your computer and its operating system. For example, 
you should know the commands for deleting and copying files and understand the 
concepts of search paths, subdirectories, and path names. Refer to your Microsoft 
Windows product documentation for more information.

You should also understand the fundamentals of Microsoft Windows, such as the 
elements of an application window. You should also be familiar with such pro-
grams as the Explorer, Taskbar or Task Manager, and Registry.

Notational Conventions
The following typographical conventions are used in this guide:

Convention Meaning

fixed-width font Text in a fixed-width font indicates commands that you enter 
exactly as shown. Text typed on a PC is not case-sensitive unless 
otherwise noted.

In commands, punctuation other than brackets ( [  ] ) and verti-
cal bars ( | ) must be entered exactly as shown.

lowercase Lowercase characters in a command statement represent a vari-
able. Substitute an appropriate value.

UPPERCASE Uppercase characters within the text represent command names, 
SQL reserved words, and keywords.



Related Publications for Installation
Before using this manual and installing the product, you should read the Release 
Notes.  The Release Notes (included as a file on the product CD) provide late-break-
ing information that may be relevant to the installation process.  

If you will be deploying your completed applications on the web, then you must 
also install the Reports Server.  (Reports Server is licensed separately; a free 30-day 
trial is available.)  The server installation is an additional step after you complete 
the instructions in this Getting Started manual.  That additional step is described in 
the manual Oracle Reports Developer: Deploying Reports Applications to the Web with Oracle 
Reports Server, A73071.

Also included on the CD are the Oracle Reports Developer and Oracle Reports 
Server products (which are licensed separately).  Those products have their own 
Getting Started manual (also included on the CD). 

boldface Boldface indicates user interface items, such as menu choices 
and buttons.

C> C> represents the DOS prompt. Your prompt may differ.

Convention Meaning
x
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Before You Install

This chapter provides some overview and background information to help you get 
ready for the actual installation and setup process that are described in the 
subsequent chapters. 

1.1 What You Receive
The primary CD in your package contains the following:

■ The Oracle Installer.

■ The Reports Developer software:   

– Report Builder (including all the design-time, compile-time, and runtime 
components)

– The other Builders in the Reports Developer family

– The Report Server component with a restricted license. This license allows 
you to deploy applications on the web for test purposes.

■ The following support products: 

– Oracle Net8 Client

– SQL*Plus, Oracle JInitiator

– Oracle OCX Pack

– Information Navigator. 

■ A number of manuals, in both online and printable format. (A copy of this 
Getting Started manual is also included.)

■ The online help (accessible both as a separate file and via the Builders), and the 
Quick Tour and Cue Cards.
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Hardware and Software Requirements
■ The Release Notes document, which contains important last-minute 
information.

The second CD in the package contains the product demos. The demos are installed 
automatically when the CD is inserted. That installation process also produces a 
configuration notes file that describes the demos.

1.2 Hardware and Software Requirements
Using Oracle Reports Developer and the related Oracle software requires the 
hardware and software described in this section. 

1.2.1 Reports Developer
The Reports Developer requires the following hardware and software to run 
optimally.

1.2.1.1 Hardware
Reports Developer is designed to be installed and run on an IBM or 100% 
compatible PC with a Pentium processor or better. A CD-ROM drive functioning as 
a logical drive is also required for the installation process. For information on 
monitor, printer, and mouse requirements, see your Microsoft Windows 
documentation. 

1.2.1.2 Operating System
This version of Reports Developer requires Microsoft Windows. Specifically, one of 
the following versions:

■ Windows 95 (any version)

■ Windows 98 (any version)

■ Windows NT 4.0 (Service Pack 5 or later) 

1.2.1.3 RAM for Design Time
To provides adequate space for installing and using the design/compile portions of 
the Reports Developer product, we suggest 128 MB of RAM. You might find that 
your project works well with less. 
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1.2.1.4 RAM for Runtime
The amount of RAM required to run a completed Report application depends on 
the following factors: 

■ The mode in which it will be deployed (web/3-tier or client-server)

■ The size and complexity of the report itself

1.2.2 Related Software
You may want to run the software described in this section on the same machine or 
off of a server running on another machine.

1.2.2.1 Database Server
Reports Developer is designed to be used with one of the following Oracle database 
servers:

■ Oracle8 (8.0.5 or 8.0.6) 

■ Oracle8i (8.1.5 or 8.1.6) 

Using the server also requires Net8 for Windows.

You can also use Personal Oracle for Windows or Personal Oracle Lite as your 
server. For the most robust support, however, Oracle8 or Oracle8i is recommended.

You can also use a non-Oracle ODBC database server if it provides the equivalent 
functions.

1.2.2.2 Web Server
If you are going to deploy your applications to the web (3-tier environment), then 
you also need a web server to act as a listener.

The Oracle WebDB Listener is provided on the Reports Developer CD, and is a 
convenient choice, but any web server can be used. Both the Common Gateway 
Interface (CGI) style and the cartridge style of listener are supported.

If you choose to use Oracle Application Server as the listener with this release of 
Reports, it must be OAS Release 4.0.8 or later.
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Where to Install Oracle
1.3 Where to Install Oracle
Oracle products are designed to reside in an installation directory referred to as 
ORACLE_HOME.

When you install Reports Developer and its related products, you will be asked to 
choose a particular ORACLE_HOME into which the product will be installed. The 
following considerations apply when you make your choice.

■ Reports Developer 6i must reside in the default ORACLE_HOME.

■ Reports Developer 6i and the Oracle8 or Oracle8i server must reside in separate 
ORACLE_HOMEs, although they can reside on the same physical machine. 

■ Similarly, in a web application deployment, Report Server and Oracle 
Application Server must reside in separate ORACLE_HOMEs, although they 
can reside on the same physical machine. 

If you intend to not only install this 6i release of Reports Developer, but also retain 
an earlier version of Oracle Developer (as this product was called in earlier 
releases), then you should be aware of the following:

■ Oracle Developer 1.6.1 and Reports Developer 6i can co-exist in the same 
ORACLE_HOME.

■ Oracle Developer 2.1 and Reports Developer 6i can co-exist in the same 
ORACLE_HOME.

■ Oracle Developer 1.6.1 and Oracle Developer 2.1 cannot co-exist in the same 
ORACLE_HOME.

■ Oracle Developer 6.0 and Reports Developer 6i cannot co-exist in the same 
ORACLE_HOME.

1.4 New Install versus Upgrade
If you are new to Reports Developer and are installing this product for the first 
time, detailed instructions are provided for you. Start with Chapter 2.

If you already have a previous version of the product and are upgrading to this 
current version, then the installation process is probably familiar to you. 
Instructions for upgrading start in Chapter 3. You will also need to consider 
recompiling your existing applications to run with this new version of the product. 
Information on that topic is also supplied in Chapter 3. 
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1.5 Deployment on Web or Client/Server
There are two environments you need to set up:

■ Design-time including the compile step. This is the environment in which the 
developers will create reports. This environment includes the build and compile 
components of the Reports Developer product. 

All the instructions for setting up the design-time environment are included in 
this manual in the following chapters. 

■ Runtime. End users run the finished reports in this environment. The 
environment includes not just the report developer application, but also the 
runtime components of the product.

– Web Runtime. Using the web to deploy your reports offers several 
advantages: easier, centralized maintenance, no storage overhead on client 
machines, and takes advantage of a powerful server.

When running your reports in a web (that is, 3-tier) environment, you need 
to perform several steps in addition to your design-time install. These steps 
install and tune the Report Server component in the middle tier. The 
instructions for those additional steps are provided in Oracle Report Server: 
Publishing Oracle Reports, A73072-01. Information on configuring the 
WebDB listener is provided in the Oracle WebDB: Installation Guide, 
A77053-01.

– Client/Server Runtime. If you are going to run your applications in a 
client/server environment, then all the instructions you need for setting up 
that environment are included in this manual in the following chapters.

1.6 Check the Release Notes
Before installing any portion of the Reports Developer product, we strongly 
recommend that you read the Release Notes for the most current product 
information.

The Release Notes contain late-breaking information that only became available 
after this Getting Started manual was printed. The Release Notes may alert you to 
changes in the installation process or the system requirements. It also lists known 
problems in the product. 
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Check the Release Notes
1.6.1 Obtaining the Release Notes
The Release Notes are contained on the product CD. To obtain the Release Notes, 
perform the following steps:

1. Start the Oracle Installer.

2. In the Installation Settings, enter your company name and select your language.

3. In the Installation Options dialog box, choose Custom Installation or Removal.

4. From the list of available products, select Oracle Reports Release Notes.

5. Choose Install.

6. When installation is complete, exit the Oracle Installer.

1.6.2 Accessing the Release Notes
To access the release note, perform the following steps:

1. Find the file relnotef in %ORACLE_HOME%\TOOLS\DOC60 where %ORACLE_
HOME% is the installation directory. The release notes are available in both text 
and PDF formats.

2. To open the text file, double-click relnotef.txt. The file will be opened in 
your default text file editor.

3. If you have Acrobat 4.0 or above installed, then open the PDF file by 
double-clicking relnotef.pdf.  

Once you have checked the release notes to see if there are any last-minute changes, 
you can begin the product installation process.
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Installing as a New Customer

This section describes installing Reports Developer where a previous version does 
not exist. The Reports Developer has both design-time and runtime components. 
You will want to install both sets of components on your development machine. 
This allows you to both create new reports and test them. You may need to install 
the runtime environment on the machines which will run the finished reports. The 
runtime environment can also be installed to run from a web site. 

2.1  Installing the Design-Time Components
Perform the following steps to install the design-time components of Reports 
Developer. 

2.1.1 Step 1: Determining the Reports Server Parameters
A limited license version of the Oracle Reports Server is provided with the Oracle 
Reports Developer. This license allows the developer to test the reports being 
developed. The Reports Server parameters are requested by the installer part way 
through the process. 

1. Determine the Reports Server TNS Service Name. The server will be installed 
on the development system and should be unique. The installer will provide a 
default name.

2. Determine the port number. The port number must not be in use by another 
process. The demo reports for this release use port number 1949.

Caution: Do NOT use the same port number used by your installation of the 
Web DB Listener.
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2.1.2 Step 2: Start the Oracle Installer

2.1.2.1 The autorun feature 
The Oracle Installer for Windows has an autorun feature that executes setup.exe 
and automatically launches the Oracle Installer when you insert the CD-ROM. Most 
users prefer to install using this automatic feature.

Note: Some older CD-ROM drives do not support the autorun feature. If the Oracle 
Installer does not start automatically, follow the steps in section 2.1.1.2 Starting the 
Oracle Installer without Autorun beginning with step 2.

2.1.2.2 Starting the Oracle Installer without autorun
To start the Oracle Installer without autorun:

1. Disable the autorun feature by holding down a shift key while inserting the CD.

2. Shut down any active Windows applications.

3. Choose Start→Run to display the Run dialog.

4. In the Run dialog box, type the following:

x:\SETUP.EXE

where x is the letter used to map your CD-ROM drive.

5. Click OK to start the Oracle Installer. The Oracle Installation Settings dialog box 
is displayed.

2.1.3 Step 3: Choose Installation Settings
Once the Oracle Installation Settings dialog box is displayed, use the following 
steps to select installation settings:

1. Enter your company name.

2. The ORACLE_HOME has been preset to DEFAULT_HOME. Keep this default 
setting.

3. In the Language dialog, select the language in which you wish to run Oracle 
Reports Developer.
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2.1.4 Step 4: Choose the Application
This installation manual assists in installing the Oracle Reports Developer. If you 
need to install additional products you will need to run the installation more than 
once. Installing the Oracle Forms Developer and the Oracle Forms Server is covered 
in Oracle Forms Developer Getting Started, A73154-01. The general installation of the 
Oracle Reports Server is the same as the Reports Developer. After the software is 
installed it must be setup.  The setup information is located in the Oracle Reports 
Developer Publishing Reports, A73173-01.

1. Choose Oracle Reports Developer.

2.1.5 Step 5: Choose an Install Method
The Oracle Installer offers you two choices for setting up the design-time 
environment:

■ Typical Installation

■ Custom Installation

2.1.5.1 Typical Installation
Selecting this option installs both the design-time components and the runtime 
components. This allows your designers to test the applications they build.

Use the following steps:

1. Select Typical Installation on this screen and click OK. 

2. In the Test Reports Server Installation Option dialog, click Yes. 

3. In the Process Startup dialog, unless you are using Oracle Enterprise Manager 
(OEM), click Yes to create and start required services now.

4. Read the text in the General Information dialog and click OK.

5. In the System Support Files dialog, click OK to upgrade your Windows files. 
These are standard Microsoft Windows files and will not be removed if you 
deinstall Reports Developer. 

6. In the Reports Server parameters dialog, enter the Reports Server TNS Name 
and the Port number determined in Section 2.1.1, "Step 1: Determining the 
Reports Server Parameters".

7. When the Configuration Instructions for Forms and Report Server dialog 
appears, write down the complete path of the configuration file. Click Later.
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The installer will display a message stating that the installation is finished.

8. Open the configuration file and follow the instructions. 

2.1.5.2 Custom installation
A Custom Installation is more complex and requires a good understand of how 
products and components relate to each other.

When you select a custom installation, the Software Asset Manager dialog is 
displayed.

The products that are available for installation are listed under Products Available. 
The plus sign (+) to the left of a product’s name indicates that this is the name of a 
software package, which consists of a main application and its supporting software. 
You can select the entire package by clicking the line with the plus icon, or you can 
double-click that line to display the pieces of the package, which can be selected 
individually.

The products that are already installed on your machine are listed under Products 
Installed. Some of these may also be software packages, and they behave as 
described in the previous paragraph.

The disk space required for your selection and the disk space currently available on 
your machine are displayed in the Space Required area below the product lists.

In the Software Asset Manager dialog, use the following steps to Custom Install:

1.  Select the product or products you want to install in the Products Available 
list.

As with other Windows-based applications, you can Shift+click to select a series 
of products from the list, or you can Ctrl+click to select multiple, discontinuous 
products.

2. Click Install.

The installation begins. We recommend that you accept the default product 
locations.

3. When installation is complete, each product you have installed is listed in the 
Products Installed list.

4. Exit the Oracle Installer and restart your system.
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The Software Asset Manager dialog box also contains the following buttons:

Button Description

Exit Closes the Software Asset Manager and exits the Oracle 
Installer.

Options . . . Allows you to do the following:

■ Request confirmations before removing or installing 
products

■ Receive detailed messages and prompts during various 
phases of the Oracle Installer’s function

■ Record the Oracle Installer’s actions in a log file

View Log . . . Displays the Event Log. The Event Log displays installation 
and configuration events in the Description Level you choose: 
Summary, Brief, and Detail. You can store and retrieve logs and 
save them to files.

By default, log files are stored in %ORACLE_
HOME%\ORAINST\ORAINST.LOG. If a log file from a previous 
installation exists, it is renamed to ORAINST.OLG.

If you want to keep more than two log files (.LOG and .OLG), 
rename the .OLG file so that it is not overwritten.

Restore Icons Restores Oracle product icons and short cuts that were deleted.

Help Displays the Installer’s online Help system.
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2.2 Installing the Runtime Components
If you are setting up a runtime environment that will operate on the web (or any 
3-tier environment), then you need to also install the Reports Server component. 
Instructions for doing so are in the manual Oracle Reports Server: Publishing Reports, 
A73071. 

On the other hand, if you will be running your applications on client machines in a 
client/server setup, follow the instructions below:

1. Start the Oracle Installer in the same way as in Section 2.1.2, "Step 2: Start the 
Oracle Installer".

2. When the Installer gives you the choice between Typical and Custom, choose 
Custom.

3. After you select Custom, the Installer will list all the available components. 
Choose the Runtime component.   

The Installer will then use the Software Asset Manager to install the Reports 
Developer runtime components.

4. When installation is complete, exit the Oracle Installer.

5. Shut down and restart Windows. 

2.3 Connecting to the Oracle Server
Connect to the Oracle Server requires that the server exists and the TNS listener 
must be up and running from the Oracle Server ORACLE_HOME. 

After completing this section you can connect from Reports Developer to the local 
database instance of the server using the connections string, NEW. For example, 
you can connect as scott/tiger@NEW.
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2.3.1 Step One: Install the Server
To test reports generated with the Reports Developer, you have to be able to access 
a database. If you do not have access to one, you will need to install one. Oracle8 or 
Oracle8i can be installed using the Installation Guide for your platform. 

Caution: Oracle8 or Oracle8i can be installed on the same physical machine as 
Reports Developer in a Windows NT environment; however, it must be in a 
separate ORACLE_HOME. For example, you might specify:

ORACLE_HOME = ora8i

Full Path = D:\orant\ora8i

2.3.2 Step Two: Specify the TNS Names
The TNS connection settings provide information that allows Oracle Reports 
Developer to connect to a database. The information is stored in the 
tnsnames.ora file, which can be updated using Oracle Net8 Easy Config or 
manually using a text editor.

Before proceeding, you will need to obtain the following database information:

Installation Defaults

Host Name ora8i.us.oracle.com

Database Port Number 1521 and 1526 are the numbers most often used in 
Oracle installations. Your installation may be 
different. Ask you database administrator for the 
correct port number.

Database System Identifier (SID) ORA8I

User ID/Password sys/change_on_install

system/manager
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2.3.2.1 Using Oracle Net8 Easy Config
After obtaining the database information, use the following steps to include your 
database connection information in your tnsnames.ora file:

1. To start the Oracle Net8 Easy Config, choose Start→Programs→Oracle for 
Windows→Oracle Net8 Easy Congfig.

2. Select Add New Service and type a New Service Name. Click Next.

The service name will be used to identify this connection when you connect in 
the Reports Developer.

3. Select the networking protocol used on your system and click Next.

4. Enter the Host Name and the Port Number and click Next.

The host name can be the IP address or the name of the machine on which the 
database resides.

5. Enter the Database SIS and click Next.

6. Click Test Service. The Test Connection dialog appears.

7. Enter the User ID and Password and click Test.

8. If the test is successful, click Done.

If the test is not successful, click Done and use the Back button to review your 
entries. After making changes, repeat steps 7 and 8.

9. Click Next and then Finish.

2.3.2.2 Editing manually
To create a TNSNAMES entry manually, use the following steps:

1.  Locate the file in:

ORACLE_HOME\net80\admin\tnsnames.ora

where ORACLE_HOME is the installation directory.

2. Open the file in any text editor.
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3. Add the following entry:

ServiceName.world
(DESCRIPTION =

(ADDRESS = )
(PROTOCOL = )
(HOST = hostName)
(PORT = portNumber)
(CONNECT_DATA = (SID =db_name) )

)
where ServiceName is the alias used to identify the connection, hostName is the 
name used by the network to identify the machine on which the database 
resides, portNumber is the database port number, and db_name is the system 
identifier.

For example, if you installed on a machine with a HOSTNAME of TEST, a SID 
containing ORA8I, on TCP/IP with port 1521, and an alias of NEW, then you 
would create the following entry:

NEW.world =
(DESCRIPTION =

(ADDRESS = )
(PROTOCOL = TCP)
(Host = TEST)
(Port = 1521)
(CONNECT_DATA = (SID = ORA8I) )

)

Note: If the host name can not be resolved, use the host’s IP address. The IP 
address can be determined by opening an MS-DOS window and typing ping.

4. Save and close the tnsnames.ora file.
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Installing as an Upgrade

This chapter explains how to install Reports Developer Release 6i when you already 
have a previous release of the product installed.

(Note that in earlier releases, the product was called Oracle Developer or 
Developer/2000.)

There are two areas to consider:

■ Upgrading the product itself -- that is, installing the new version of the 
software.

■ Upgrading your existing applications -- that is, recompiling your applications 
with the new version of the product.

3.1 Upgrading the Product
Warning: Do not install or build the Oracle Reports Developer database tables until 
you run the appropriate upgrade script. If you have customized your product 
resource (.RES) files (e.g., fmrusw.res), you should backup these files before 
upgrading.

■ Product resource (.RES) files

■ tnsnames.ora 

■ sqluct.ora 
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3.1.1 Version Issues

3.1.1.1 Upgrading From Versions Before 6.0
All of your currently-installed components require upgrading. This is especially 
important if you have been using Release 1 or 2. Because of improvements to the 
underlying support files, such as the Tools Utilities, GUI Common files, and 
Required Support Files, the older set of components cannot run with the newer set.

If you have used previous versions of Reports Developer on Microsoft Windows 
3.x, your ORACLE_HOME directory was called ORAWIN. When you upgraded your 
operating system to Windows 95, 98, or NT, your old ORAWIN directory was 
retained. 

The installation of Reports Developer Release 6i creates a new ORACLE_HOME 
directory. This new directory is named either ORAWIN95 (on Windows 95), 
ORAWIN98 (on Windows 98), or ORANT (on Windows NT). In any case, your old 
ORAWIN directory is not used or overwritten.

3.1.1.2 Upgrading from Release 6.0 and 6i
Upgrading from Release 6.0 to this 6i release does not require a full reinstall.

3.1.2 Running the Oracle Installer
Use the Oracle Installer to install the new version of the product from the CD. If you 
are not familiar with this tool or the options, follow the instructions in the 
Chapter 2, "Installing as a New Customer". 

Remember that if you are going to deploy applications to the web, you should also 
install/upgrade the new version of the Reports Server.

3.1.3 Server Considerations:
Listeners that support CGI (Common Gateway Interface), servlets, or OAS are 
supported in Reports Developer Release 6i. 

The Oracle WebDB Listener is provided on the Reports Developer CD, and is a 
convenient choice, but any web server can be used.
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If you are currently using Developer Release 6.0 and Oracle Application Server 
(OAS) Release 4.0.7, and you want to continue using OAS with Reports Release 6 i, 
then you need to also install OAS Release 4.0.8. Be aware of the following 
considerations:

■ You must install OAS 4.0.8 into a separate ORACLE_HOME from Reports 
Developer 6i.

■ You must install OAS 4.0.8 into a separate ORACLE_HOME from OAS 4.0.7. Do 
not overlay or deinstall 4.0.7. 

There also are likely to be additional cartridge upgrade requirements if you install 
OAS 4.0.8. Please see the Reports Developer Release Notes for the latest 
information.

3.2 Upgrading Your Applications
If you want to run your old applications (applications that were created with a 
version prior to Release 6) on this new version of the product, those applications 
need to be recompiled after you have the new product version installed. 

When upgrading applications, please keep the following in mind:

■ We strongly recommend that you make a backup of all modules before 
beginning the conversion process.

■ In general, applications are upwards compatible. However, there are 
occasionally minor differences in functionality. 

See the sections New Features and Compatibility with Previous Releases in the 
online help for specifics. Additional compatibility information can be found on 
these websites:

– http://technet.oracle.com/products/developer/

– http://technet.oracle.com/products/reports/

Chapter 6 of the Oracle8 Server Migration manual contains additional 
information on compatibility between releases. 

■ Applications that were built with SQL*Report or SQL*Reportmate Release 1, 2, 
or 3 cannot be moved directly to the 6i release for recompile. Instead, you must 
first recompile them with versions 4.0, 4.5, or 5.0. After that intermediate 
conversion, you can then recompile them again on this release.
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■ Reports Developer Release 6i includes a PL/SQL conversion utility for 
converting modules based on PL/SQL version 1 or 2 to PL/SQL version 8, 
which is the version this release is based on. If you are upgrading from a release 
prior to Developer 2000, you will need to convert all modules (Reports, 
Graphics, and PL/SQL libraries) to the newer version of PL/SQL. The 
conversion utility runs automatically whenever you open a report containing 
PL/SQL version 1 or 2, allowing you to interactively perform the conversion. 
The conversion can also be run automatically in batch mode. 

See Chapter 6 of the Oracle8 Server Migration for more detailed information on 
the PL/SQL conversion utility.

■ If you are upgrading applications that contain user exits and user-created DLLs, 
those DLL files may need to be recompiled after recompiling your applications 
with the new release.

Applications that make calls through the Reports Developer foreign function 
interface (ORA_FFI package) to 16-bit DLLs will not work under Windows 
95/98/NT due to an operating system incompatibility between 16-bit code and 
32-bit executables. The DLL must be recompiled/linked as a 32-bit DLL.

■ Applications that use VBX controls do not run properly under Windows 
95/98/NT due to an operating system incompatibility between 16-bit VBX 
controls and 32-bit executables. OCX/ActiveX controls are the equivalent for a 
32-bit environment.

3.2.1 Redeploying Your Applications on the Web
After you recompile your older applications with this release, they are eligible to be 
deployed on the web.

For instructions, consult the manual Oracle Reports Server Building Reports, A73071. 
Information can also be found on the following website:   
http://technet.oracle.com/products/reports/.
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Deinstalling

4.1 Removing the Reports Developer Product

If at any time you need to back out or remove Reports Developer from your system, 
it is strongly recommended that you use the Oracle Installer for that deinstall task. 

The Oracle Installer is specifically designed to both install and deinstall Oracle 
products. When deinstalling, it is important to remove all components and related 
items. The Oracle Installer will automatically do this for you. 

Note: If you are not using the standard Windows application to control your 
desktop (you are using Central Point PC Tools or Norton Desktop, for example), the 
Oracle Installer may not remove program items correctly. 

If you are not able to use the Oracle Installer to do the deinstall, then you need to be 
sure to also remove all the registry entries related to the services created during the 
installation of Reports Developer, and to remove ORACLE_HOME and ORACLE 
registry keys. (You can use the registry editor provided with Windows for this task.)

4.1.1 Stopping services
If you are running on NT, you must stop any services that would be affected by the 
deinstall.

1. Close any Oracle applications that you are running on this machine.

2. Choose Start→Settings→Control Panel→Services to display the Services 
dialog.
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3. Select the Oracle Reports Server (ServerName) and click Stop.

Note: There may be more than one Oracle Reports Server.

4. Select the Oracle Web DB Listener and click Stop.

WARNING: If you have created any similar services yourself during installation, 
you must also stop those services.

4.1.2 Removing Reports Developer
To remove Reports Developer from your system, use the following steps:

1. Start the Oracle Installer from your Oracle product media or choose 
Start→Programs→Oracle for Windows→Oracle Installer. 

See Chapter 2 for additional instructions on starting the Oracle Installer.

2. In the Installation Options dialog, select Custom Installation or Removal.

3. In the Products Installed list box, select the product you want to remove from 
your system.

4. Click Remove. If the products you select to deinstall affect other products, 
Oracle Developer displays a confirmation prompt before deinstalling.

5. If you are going to reinstall Reports Developer after the deinstall, you will first 
need to reboot the machine.   
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Setting Up Tables to Store Applications

You or your database administrator can set up tables in the database that will allow 
application modules to be saved to the Oracle Server. 

For Report Builder, and most of the other Builders, this is an optional step; 
applications do not need to be saved in the server. However, for Translation Builder 
and Schema Builder, these database tables are a requirement.

If they have the option, most customers choose to not store their applications in the 
server, and they skip this step. Those who do choose to store applications in the 
server usually do so for the benefits of centralized administrative control.

The following topics are included in this chapter:

■ Building the Database Tables

■ Proper Use of these Tables

■ Granting and Revoking User Access

■ Deleting the Database Tables

■ Upgrading the Database Tables

Creating database tables may require administrator privileges. Consult with your 
database administrator if such authorization is required. 

5.1 Building the Database Tables
Caution: These instructions are for new installations only. If you already have 
database tables installed for a previous version of an Oracle Developer product, be 
aware that removing the existing tables or attempting to install the database tables 
for the current version of Reports Developer will destroy any Oracle Developer 
module currently stored in the database. Please see Section 5.5, "Upgrading the 
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Database Tables" on page 5-39 for instructions on upgrading existing database 
tables.

When you create applications with Reports Developer, you can either save your 
modules as files or save them to the server. Saving modules to the server conserves 
disk space on client machines and allows shared access to the modules, although 
access to modules stored on the server can be slower than when they are stored as 
files on the client machine. You may wish to consider the following information 
when deciding where to store your modules.

Before users can save modules to the server, a system administrator must build 
tables to accommodate the modules and grant access privileges to users who will 
work with those tables. 

5.1.1 Step 1: Installing the SQL scripts with the Oracle Installer
The SQL scripts are not installed as part of the typical install. If you have not 
already done so, use the Oracle Installer to install the SQL scripts needed to build 
and administer the Reports Developer database tables.

To install the SQL scripts, use the following steps:

1. Start the Oracle Installer and select Custom Installation or Removal from the 
Reports Developer Installation Options dialog box. (Refer to Chapter 1 for more 
information on the Oracle Installer.)

2. Select Reports Developer Database Tables from the Available Products list.

3. Click Install.

Installing these scripts creates a Start menu item called Reports Developer R6i 
Admin and the associated submenu items Reports Developer Build, Drop, Grant, 

Storage Location When to Use

Database server When you want security that is not provided by your operating 
system.

When you want to store applications on the client machine, but 
you do not have enough disk space.

When you want to share applications with other users.

When module access speed is not as important as the 
considerations listed above.

File system When the above criteria are not true or not important.
5-36 Oracle Reports Developer Getting Started



Granting and Revoking User Access
and Revoke. These menu items, when selected, run a script or a series of scripts to 
perform database administration tasks.

5.1.2 Step 2: Building the Oracle Developer database tables
To build the Oracle Developer database tables:

1. Click Start→Programs→Oracle Forms and Reports R6i Admin→Build.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVBILD.SQL

2. Enter the password.  The password installed with new systems is manager.

3. Enter the database connection. The connection is made up of the database name 
followed by .world.  The database must appear in you tnsnames.ora file.

4. Follow the script.

5.2 Proper Use of these Tables
Reports Builder and the other Builders use the database tables for storing modules. 
The database tables are not intended for any other use. The structure and 
organization of the tables are likely to change from release to release. We strongly 
recommend that you do not try to use SQL queries against the tables to produce 
reports or documentation about your modules. Use of the tables in this way is not 
supported by Oracle. For this reason, the structure and content of the tables are not 
provided.

For more information about database roles, see the Oracle8 or Oracle8i 
documentation.

5.3 Granting and Revoking User Access
After building the Reports Developer database tables, you must grant user access to 
the tables. If you wish to withdraw access from a user, you must revoke it. Both of 
these tasks are accomplished with SQL scripts provided through the Oracle 
Installer.
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5.3.1 Granting access to the database tables 
You must perform this task for each user who requires access to the tables. 
Alternatively, you can grant access to all users simultaneously by granting access 
for user PUBLIC. 

To grant access to the Reports Developer database tables, use the following steps:

1. Click Start→Programs→Oracle Forms and Reports 6i Admin→Grant 

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVGRNT.SQL username

2. Enter the password.  The password installed with new systems is manager.

3. Enter the database connection. The connection is made up of the database name 
followed by .world.  The database must appear in you tnsnames.ora file.

4. Enter the username of a user to whom you will grant access to the tables.

To grant access to all users, enter PUBLIC and skip step 5.

5. Repeat steps 1 and 2 for each user to whom you want to grant access.

5.3.2 Revoking access to the database tables 
You must perform this task for each user whose access to the tables you want to 
revoke. Alternatively, you can revoke access for all users simultaneously by 
revoking access for user PUBLIC. 

To revoke access to the Reports Developer database tables, use the following steps:

1. Click Start→Programs→Oracle Forms and Reports  R6i Admin→Revoke 

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVRVKE.SQL username

2. Enter the password.  The password installed with new systems is manager.

3. Enter the database connection. The connection is made up of the database name 
followed by .world.  The database must appear in you tnsnames.ora file.
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4. Enter the username of the user whose access you wish to revoke.

To revoke access from all users, enter PUBLIC and skip step 5.

5. Repeat steps 1 and 2 for all users whose access you wish to revoke.

5.4 Deleting the Database Tables
Caution: Deleting the database tables erases any module stored in those tables. Do 
not delete database tables until you have verified that you do not need any module 
currently stored in the table or tables you intend to delete. See Section 5.5.1 for more 
information on backing up modules currently stored in your database.

To delete the Reports Developer database tables:

1. Click Start→Programs→Oracle Forms and Reports R6i Admin→Drop.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVDRP.SQL

2. Enter the password.  The password installed with new systems is manager.

3. Enter the database connection. The connection is made up of the database name 
followed by .world.  The database must appear in you tnsnames.ora file.

4. Follow the script.

5.5 Upgrading the Database Tables
If you are upgrading from Release 1 to Release 6i of Oracle Reports Developer, the 
only database tables that need upgrading are those for Translation Builder.   Tables 
for the other Builders (Form Builder, Graphics Builder, Procedure Builder, Query 
Builder, and Schema Builder), and the common tables, do not need to be upgraded. 

You can run one or more upgrade scripts instead of creating the tables from scratch. 
Doing so updates the administration information in your existing tables. 
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5.5.1 Step 1: Back up the database contents
If you have any modules stored in the database that you wish to continue using 
after you upgrade the database tables, you will need to back up these modules. Any 
modules that you do not back up will be lost.

Before you back up existing modules, it might be useful to have a list of all available 
modules currently stored in the database. To do this, log on to the database and run 
the following SQL script:

column product format a15
column modtype format a15
SELECT product, modtype, owner, modname
FROM tool_module
ORDER BY product, modtype, owner;

You can recognize the source files for application modules by their file extensions:

Table 5–1 Application module extensions

Application Module Extensions

Form Builder .FMB, .MMB, and .PLL

Report Builder .RDF and .SQL

Graphics Builder .OGD

Procedure Builder .PLL

Query Builder .BRW and .SQL
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5.5.1.1 Backing up a module
To back up a module, use the following steps:

1. Open the module in the appropriate Builder.

2. Save the module as an operating system file using the File→Save As command.

5.5.1.2 Step 2: Upgrade the tables
Once you have backed up the database, you can upgrade the Translation Builder 
database tables.

Note: Run all SQL scripts under the SYSTEM account.

Upgrade the existing tables by running the following script:

%ORACLE_HOME%\TOOLS\DBTAB60\OTM60\SQLMIG.SQL

5.5.1.3 Step 3: Restore the database contents
Once you have completed upgrading the database tables, you can restore the 
modules to the database.

To restore a module, use the following steps:

1. Open the module in the appropriate Builder.

2. Save the module as a database module using the File→Save As command.

5.5.1.4 Step 4: Grant user access again 
After you have upgraded from a previous version, you must once again grant user 
access to the database tables. See Section 5.3 for information about how to do this.
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What’s Next?

You’ve completed the installation of the Reports Developer product. What’s the 
next step?

6.1 If You’re a New Reports Developer
Start familiarizing yourself with the features of this product, and learning how to 
create reports applications.

A good place to begin is with the Quick Tour. This is included with the product CD, 
and has now been installed and made available. To access the Quick Tour, start 
Report Builder, and on its Welcome screen, choose the option Run the Quick Tour. 
You can also start the Quick Tour from the Help menu on any of the Builders.

After completing the Quick Tour, move on to the detailed documentation in the 
manuals and the online help topics.

You may also wish to install and examine the product demos supplied on a separate 
CD in your package. They offer another good source for learning about the product.

Supplementary information is occasionally created for users of this product. You 
can access this material (white papers, for example) on the Oracle Reports Devel-
oper websites at http://www.oracle.com/tools/developer/ and http://tech-
net.oracle.com/products/reports/.
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6.2 If You’re an Experienced Reports Developer
Look at the New Features section in the online help, Report Builder Help Topics. This 
offers a quick summary of new functionality in this release. There is also a What’s 
New section under Features & Benefits in the Quick Tour. 

Also look at the Compatibility with Previous Releases section in the online help. This 
provides an overview of behavior that has changed.

For details about a particular new feature or behavior, see the specific help topics 
and/or sections in the manuals.

A new manual is available with this release: Oracle Reports Server: Building Reports, 
A73071. This manual can help you understand the benefits of web deployment, and 
the steps to take to accomplish that.

It is also useful to occasionally check the Oracle Developer website at     
http://www.oracle.com/tools/developer/ and the Oracle Reports website at 
http://technet.oracle.com/products/reports/. Helpful supplementary information 
is posted there. 
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Oracle Express

This appendix provides information that will help you integrate Oracle Express 
with Oracle Reports. It contains:

■ Configuring Reports for Oracle Express

■ Specifying the buffer size

■ Specifying the character set

■ Specifying number ranges

A.1 Configuring Reports for Oracle Express
If you want to create reports that use Express data, you must configure your system 
as follows:

■ On the server, install an Oracle8 Server with the necessary PL/SQL packages.

■ On the client, install the Reports Express Support component and the Oracle 
Express Connection Editor.
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System Requirements:

■ Windows 95, 98, or NT

■ Express Server Release 6.2 or later

■ Oracle8 Release 8.0.6 

■ Reports Release 6i

Note:  For individual product requirements, refer to the Express Server and Oracle8 
installation information for your platform. If Oracle8 is running on a different 
platform, you may need to download the reports Express component from Oracle 
Technology Network at http//technet.oracle.com/products/reports/.
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Usage Notes

■ It is strongly recommended that you use only Express databases that have been 
configured with Express Administrator. Refer to the Oracle Express Database 
Administration Guide for more information on configuring databases with 
Express Administrator.

■ You cannot access an Express database ( .DB) file that requires a password from 
Reports.

■ Personal Express is not supported by Reports in this release.

A.1.1 Client side configuration
1. Insert the CD that contains the Oracle Reports product. If your CD-ROM drive 

supports the AUTORUN feature, the Oracle Installer will start automatically. 
Otherwise, perform the following steps:

a. Shut down any active Windows applications. 

b. Open the Run dialog box from the Start menu. 

c. In the Run dialog, type the following (where X: is your CD-ROM drive 
letter): 

X:\SETUP.EXE

d. Click OK to start the Oracle Installer. 

2. When you reach the Installation Options dialog of the installer, choose Custom 
Installation or Removal and click OK.

3. From the Available Products list, select Reports Express Support and Oracle 
Express Connection Editor from the list. 

Tip: Press the CTRL key while clicking to make multiple selections. 

4. Click Install.

Note: If your connections to the Express Server have not already been set up, 
you can use the Oracle Express Connection Editor for that purpose. From 
Report Builder, choose Start→Programs→Oracle Olap Client 2.2→Connection 
EditorStart Programs->Oracle Olap Client 2.2->Connection Editor.
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A.1.2 Server side configuration
There are four tasks involved in server side configuration: 

■      Installing Oracle8 Server Release 8.0.6

■      Installing Express External Oracle8 Procedures

■      Creating an Express Support administrator account on Oracle8 server

■      Preparing user accounts with Express Support schema objects

A.1.2.1 Installing Oracle8 Server Release 8.0.6
Refer to the Oracle8 installation guide for your platform.

A.1.2.2 Installing Express External Oracle8 Procedures
1. Insert the CD that contains the Oracle Reports product. If your CD-ROM drive 

supports the AUTORUN feature, the Oracle Installer will start automatically. 
Otherwise, perform the following steps:

a. Shut down any active Windows applications.

b. Open the Run dialog box from the Start menu.

c. In the Run dialog, type the following (where X: is your CD-ROM drive 
letter):

 X:\SETUP.EXE

d.   Click OK to start the Oracle Installer.

2. When you reach the Installation Options dialog of the installer, choose Custom 
Installation or Removal and click OK.

3. From the Available Products list, click the plus sign (+) to expand the Reports 
Express Support node and choose Express External Oracle8 Procedures from 
the list.

4. Click Install.
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A.1.2.3 Creating an Express Support administrator account on Oracle8 server
Only one Express Support administrator account is required for each Oracle8 
instance. If the account and the required schema objects already exist, skip this step 
and go to Section A.1.2.4, "Preparing user accounts with Express Support schema 
objects".

1. Log into SQL*Plus as the SYSTEM user and create and grant the administrator 
account CREATE LIBRARY, CREATE PUBLIC SYNONYM, and CREATE 
SEQUENCE privileges. For example, if the administrator was named expadmin, 
the following commands would set up the necessary privileges:

SQL> create user expadmin identified by expadmin default tablespace
user_data temporary tablespace temporary_data quota unlimited on user_
data quota unlimited on temporary_data;
SQL> grant connect,resource to exadmin; 
SQL> grant create library, create public synonym, create sequence to 
expadmin;

2. Log into SQL*Plus as the administrator (e.g., expadmin) and run the SQL script 
that installs the administrator schema objects:

SQL> @ ORACLE_HOME\olap\xrb60\xrb_admin.sql;

A.1.2.4 Preparing user accounts with Express Support schema objects
You must create Express Support schema objects for any schema that uses Express 
Support. Using existing Express Support schema objects installed on another 
schema is not supported.

Note: If you do not have a user account, you must create one before proceeding 
with this step.

1. Log on to SQL*Plus as the SYSTEM user and grant the user account CREATE 
TYPE and CREATE PROCEDURE privileges. For example, if the user was        
named expuser, the following commands would set up the necessary 
privileges:

 SQL> grant create type, create procedure to expuser;

2. Log on to SQL*Plus as the user and run the SQL script that installs the Express 
Support schema objects:

 SQL> @ ORACLE_HOME\olap\xrb60\xrb_user.sql;
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A.1.2.5 Runtime parameter requirements
If deploying a report built against Express with the Oracle Reports Server (for 
example, for running over the web), the following runtime parameter is required in 
addition to the userid, server, desformat, etc. parameters that would also be 
specified:

express_server="server=ncacn_ip_tcp:my_express_server/sl=1/st=1/ct=0/sv=1/"

where my_express_server is the hostname of the server running Oracle Express 
Server.

A.2 Buffer Size for Express Data

A.2.1 Default buffer size
When a user creates a report that contains Express data, that data must be fetched 
from Express and stored in a memory buffer before it is displayed. The default 
buffer size is generally sufficient for most circumstances, and you can probably 
accept the default size of the buffer and not worry about making any changes.

Why specify a buffer size?

You can specify a larger or smaller size for the buffer than the default value 
specifies. For example, if users generate many small reports, you might want to 
reduce the buffer size. If users generate very large reports, you might need to 
increase the size.

You change the default size of the buffer in the xrb.ini file. You must bear in mind 
that this file resides on the Oracle8 Server and is shared by many users. The server 
allocates the same size buffer to all users of that server for the duration of the time 
that data is being fetched from Express. Use care when specifying the size to fit the 
needs of the many users who are concurrently accessing Express data. The size 
should be large enough to allow users to fetch the data for their reports while 
ensuring that the server has sufficient memory.
A-52 Oracle Reports Developer Getting Started



Buffer Size for Express Data
A.2.2 Buffer sizes
The following list describes some of the buffer sizes:

■ 64KB: This is the minimum buffer size that is allowed. Even if you specify a 
smaller size, the buffer will have a size of 64KB.

■ 2MB: This is the default buffer size.  If you do not specify a different size, the 
buffer will have a size of 2MB.

■ 50MB: This is the maximum buffer size that is allowed. Even if you specify a 
larger size, the buffer will have a size of 50MB. You must ensure that the 
Oracle8 server has a very large amount of memory before specifying such a 
large buffer size. 

A.2.3 Specifying the buffer size
To specify the buffer size, you must create or modify the xrb.ini file, so that the 
setting can take effect. The following procedure explains how to make the 
specification in the file.

1. On the computer on which Oracle8 is running, look in the ORACLE_
HOME/BIN directory for a file called xrb.ini. If the file exists, proceed to 
step 3. Otherwise, proceed to step 2.

2. With a text editor, create a file called xrb.ini in the ORACLE_HOME/BIN 
directory.

3. In a text editor, scroll to the [Options] section of the file, or create this section 
label if it does not exist.

4. Edit the value of the FetchAlloc setting if it exists; otherwise, create the setting.  
Enter an integer value, such as 100000 or 6000000.

5. Save your changes and close the file.

A.2.4 Example setting for a buffer size
The following example shows a sample setting of 4MB for the buffer size.

[Options]
FetchAlloc = 4000000
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A.3 Single-Byte Character Sets

A.3.1 Specifying the character set from Express
If you have changed the default single-byte character set in Express, you must 
create or modify the xrb.ini file for Oracle Reports Developer so that it can handle 
data from the Express database appropriately. The xrb.ini file is used it to specify 
information about the character set that the database is using. The following 
procedure explains how to make the specification in the file.

1. On the machine where Oracle8 is running, look in the ORACLE_HOME\BIN 
directory for the xrb.ini file. If the file exists, go to Step 3. Otherwise, go to 
Step 2.

2. With a text editor, create the xrb.ini file in the ORACLE_HOME\BIN 
directory.

3. In a text editor, scroll to the [XPCharSet] section of the file, or create this section 
label if it does not exist.

4. Edit the value of the XPCharSet setting if it exists; otherwise, create the setting.  
Use the following format for the value:

language_territory.charset
where language, territory, and charset are values obtained from the following 
tables.

5. Save your changes and close the file.

A.3.2 Example setting for a character set
The following example shows a sample setting for the character set.

[XPCharSet]
XPCharSet = AMERICAN_AMERICA.US8PC437
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A.3.3 Languages
The following table lists the values to enter for language in the XPCharSet setting.  
If the value has multiple words, include a space between each word, as shown in 
the following example.

[XPCharSet]
XPCharSet = BRAZILIAN PORTUGUESE_BRAZIL.WE8PC850

Language

AMERICAN

ARABIC

BENGALI

BRAZILIAN PORTUGUESE

BULGARIAN

CANADIAN FRENCH

CATALAN

CROATION

CZECH

DANISH

DUTCH

EGYPTIAN

ENGLISH

ESTONIAN

FINNISH

FRENCH

GERMAN DIN

GERMAN

GREEK

HEBREW

HUNGARIAN

ICELANDIC
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ITALIAN

JAPANESE

KOREAN

LATIN AMERICAN SPANISH

LATVIAN

LITHUANIAN

MALAY

MEXICAN SPANISH

NORWEGIAN

POLISH

PORTUGESE

ROMANIAN

RUSSIAN

SIMPLIFIED CHINESE

SLOVAK

SLOVENIAN

SPANISH

SWEDISH

THAI

TRADITIONAL CHINESE

TURKISH

UKRAINIAN

VIETNAMESE

Language
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A.3.4 Territories
The following table lists the values to enter for territory in the XPCharSet setting.

Territory

ALGERIA

AMERICA

AUSTRIA

BAHRAIN

BANGLADESH

BRAZIL

BULGARIA

CANADA

CATALONIA

CHINA

CIS

CROATIA

CZECH REPUBLIC

CZECHOSLOVAKIA

DENMARK

DJIBOUTI

EGYPT

ESTONIA

FINLAND

FRANCE

GERMANY

GREECE

HONG KONG

HUNGARY

ICELAND
Oracle Express A-57



Single-Byte Character Sets
IRAQ

ISRAEL

ITALY

JAPAN

JORDAN

KOREA

KUWAIT

LATVIA

LEBANON

LIBYA

LITHUANIA

MALAYSIA

MAURITANIA

MEXICO

MOROCCO

NORWAY

OMAN

POLAND

PORTUGAL

QATAR

ROMANIA

SAUDI ARABIA

SLOVAKIA

SLOVENIA

SOMALIA

SPAIN

SUDAN

SWEDEN

Territory
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A.3.5 Storage character sets
The following table lists the values to enter for charset in the XPCharSet setting.  
The value is specified in the Name column.

SWITZERLAND

SYRIA

TAIWAN

THAILAND

THE NETHERLANDS

TUNISIA

TURKEY

UKRAINE

UNITED ARAB EMIRATES

UNITED KINGDOM

VIETNAM

YEMEN

ID Name Description

1 US7ASCII ASCII 7-bit American

2 WE8DEC DEC 8-bit West European

3 WE8HP HP LaserJet 8-bit West European

4 US8PC437 IBM-PC Code Page 437 8-bit American

5 WE8EBCDIC37 EDCDIC Code Page 37 8-bit West European

6 WE8EBCDIC500 EDCDIC Code Page 500 8-bit West European

8 WE8EBCDIC285 EDCDIC Code Page 285 8-bit West European

10 WE8PC850 IBM-PC Code Page 850 8-bit West European

11 D7DEC DEC VT100 7-bit German

12 F7DEC DEC VT100 7-bit French

13 S7DEC DEC VT100 7-bit Swedish

Territory
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14 E7DEC DEC VT100 7-bit Spanish

15 SF7ASCII ASCII 7-bit Finnish

16 NDK7DEC DEC VT100 7-bit Norwegian/Danish

17 I7DEC DEC VT100 7-bit Italian

18 NL7DEC DEC VT100 7-bit Dutch

19 CH7DEC DEC VT100 7-bit Swiss (German/French)

20 YUG7ASCII ASCII 7-bit Yugoslavian

21 SF7DEC DEC VT100 7-bit Finnish

22 TR7DEC DEC VT100 7-bit Turkish

23 IW7IS960 Israeli Standard 960 7-bit Latin/Hebrew

25 IN8ISCII Multiple-Script Indian Standard 8-bit Latin/Indian 
Languages

31 WE8IS08859P1 ISO 8859-1 West European

32 EE8ISO8859P2 ISO 8859-2 East European

33 SE8ISO8859P3 ISO 8859-3 South European

34 NEE8ISO8859P4 ISO 8859-4 North and North-East European

35 CL8ISO8859P5 ISO 8859-5 Latin/Cyrillic

36 AR8ISO8859P6 ISO 8859-6 Latin/Arabic

37 EL8ISO8859P7 ISO 8859-7 Latin/Greek

38 IW8ISO8859P8 ISO 8859-8 Latin/Hebrew

39 WE8ISO8859P9 ISO 8859-9 West European & Turkish

40 NE8ISO8859P10 ISO 8859-10 North European

41 TH8TISASCII Thai Industrial Standard 620-2533 - ASCII 8-bit

42 TH8TISEBCDIC Thai Industrial Standard 620-2533 - EBCDIC 8-bit

43 BN8BSCII Bangladesh National Code 8-bit BSCII

44 VN8VN3 VN3 8-bit Vietnamese

50 WE8NEXTSTEP NeXTSTEP PostScript 8-bit West European

70 AR8EBCDICX EBCDIC XBASIC Server 8-bit Latin/Arabic

ID Name Description
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81 EL8DEC DEC 8-bit Latin/Greek

82 TR8DEC DEC 8-bit Turkish

90 WE8EBCDIC37C EBCDIC Code Page 37 8-bit Oracle/c

91 WE8EBCDIC500C EBCDIC Code Page 500 8-bit Oracle/c

92 IW8EBCDIC424 EBCDIC Code Page 424 8-bit Latin/Hebrew

93 TR8EBCDIC1026 EBCDIC Code Page 1026 8-bit Turkish

94 WE8EBCDIC871 EBCDIC Code Page 871 8-bit Icelandic

95 WE8EBCDIC284 EBCDIC Code Page 284 8-bit Latin American/Spanish

110 EEC8EUROASCI EEC Targon 35 ASCI West European/Greek

113 EEC8EUROPA3 EEC EUROPA3 8-bit West European/Greek

114 LA8PASSPORT German Government Printer 8-bit All-European Latin

140 BG8PC437S IBM PC Code Page 437 8-bit (Bulgarian Modification)

150 EE8PC852 IBM PC Code Page 852 8-bit East European

152 RU8PC866 IBM PC Code Page 866 8-bit Latin/Cyrillic

153 RU8BESTA BESTA 8-bit Latin/Cyrillic

154 IW8PC1507 IBM PC Code Page 1507/862 8-bit Latin/Hebrew

155 RU8PC855 IBM PC Code Page 855 8-bit Latin/Cyrillic

156 TR8PC857 IBM PC Code Page 857 8-bit Turkish

158 CL8MACCYRILLIC Mac Client 8-bit Latin/Cyrillic

159 CL8MACCYRILLICS Mac Server 8-bit Latin/Cyrillic

160 WE8PC860 IBM PC Code Page 860 8-bit West European

161 IS8PC861 IBM PC Code Page 861 8-bit Icelandic

162 EE8MACCES Mac Server 8-bit Central European

163 EE8MACCROATIANS Mac Server 8-bit Croatian

164 TR8MACTURKISHS Mac Server 8-bit Turkish

165 IS8MACICELANDICS Mac Server 8-bit Icelandic

166 EL8MACGREEKS Mac Server 8-bit Greek

167 IW8MACHEBREWS Mac Server 8-bit Hebrew

ID Name Description
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170 EE8MSWIN1250 MS Windows Code Page 1250 8-bit East European

171 CL8MSWIN1251 MS Windows Code Page 1251 8-bit Latin/Cyrillic

172 ET8MSWIN923 MS Windows Code Page 923 8-bit Estonian

173 BG8MSWIN MS Windows 8-bit Bulgarian Cyrillic

174 EL8MSWIN1253 MS Windows Code Page 1253 8-bit Latin/Greek

175 IW8MSWIN1255 MS Windows Code Page 1255 8-bit Latin/Hebrew

176 LT8MSWIN921 MS Windows Code Page 921 8-bit Lithuanian

177 TR8MSWIN1254 MS Windows Code Page 1254 8-bit Turkish

178 WE8MSWIN1252 MS Windows Code Page 1252 8-bit West European

179 BLT8MSWIN1257 MS Windows Code Page 1257 8-bit Baltic

180 D8EBCDIC273 EBCDIC Code Page 273/1 8-bit Austrian German

181 I8EBCDIC280 EBCDIC Code Page 280/1 8-bit Italian

182 DK8EBCDIC277 EBCDIC Code Page 277/1 8-bit Danish

183 S8EBCDIC278 EBCDIC Code Page 278/1 8-bit Swedish

184 EE8EBCDIC870 EBCDIC Code Page 870 8-bit East European

185 CL8EBCDIC1025 EBCDIC Code Page 1025 8-bit Cyrillic

186 F8EBCDIC297 EBCDIC Code Page 297 8-bit French

187 IW8EBCDIC1086 EBCDIC Code Page 1086 8-bit Hebrew

188 CL8EBCDIC1025X EBCDIC Code Page 1025 (Modified) 8-bit Cyrillic

190 N8PC865 IBM-PC Code Page 865 8-bit Norwegian

191 BLT8CP921 Latvian Standard LVS8-92(1) Windows/Unix 8-bit Baltic

192 LV8PC1117 IBM-PC Code Page 1117 8-bit Latvian

193 LV8PC8LR Latvian Version IBM-PC Code Page 866 8-bit 
Latin/Cyrillic

194 BLT8EBCDIC1112 EBCDIC Code Page 1112 8-bit Baltic Multilingual

195 LV8RST104090 IBM-PC Alternative Code Page 8-bit Latvian 
(Latin/Cyrillic)

196 CL8KOI8R RELCOM Internet Standard 8-bit Latin/Cyrillic

197 BLT8PC775 IBM-PC code Page 775 8-bit Baltic

ID Name Description
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201 F7SIEMENS9780X Siemens 97801/97808 7-bit French

202 E7SIEMENS9780X Siemens 97801/97808 7-bit Spanish

203 S7SIEMENS9780X Siemens 97801/97808 7-bit Swedish

204 DK7SIEMENS9780X Siemens 97801/97808 7-bit Danish

205 N7SIEMENS9780X Siemens 97801/97808 7-bit Norwegian

206 I7SIEMENS9780X Siemens 97801/97808 7-bit Italian

207 D7SIEMENS9780X Siemens 97801/97808 7-bit German

210 WE8GCOS7 Bull EBCDIC GCOS7 8-bit West European

211 EL8GCOS7 Bull EBCDIC GCOS7 8-bit Greek

221 US8BS2000 Siemens 9750-62 EBCDIC 8-bit American

222 D8BS2000 Siemens 9750-62 EBCDIC 8-bit German

223 F8BS2000 Siemens 9750-62 EBCDIC 8-bit French

224 E8BS2000 Siemens 9750-62 EBCDIC 8-bit Spanish

225 DK8BS2000 Siemens 9750-62 EBCDIC 8-bit Danish

231 WE8BS2000 Siemens EBCDIC.DF.04 8-bit West European

235 CL8BS2000 Siemens EBCDIC.EHC.LC 8-bit Cyrillic

239 WE8BS2000L5 Siemens EBCDIC.DF.04.L5 8-bit West European/Turkish

241 WE8DG DG 8-bit West European

251 WE8NCR4970 NCR 4970 8-bit West European

261 WE8ROMAN8 HP Roman8 8-bit West European

262 EE8MACCE Mac Client 8-bit Central European

263 EE8MACCROATIAN Mac Client 8-bit Croatian

264 TR8MACTURKISH Mac Client 8-bit Turkish

265 IS8MACICELANDIC Mac Client 8-bit Icelandic

266 EL8MACGREEK Mac Client 8-bit Greek

267 IW8MACHEBREW Mac Client 8-bit Hebrew

277 US8ICL ICL EBCDIC 8-bit American

278 WE8ICL ICL EBCDIC 8-bit West European

ID Name Description
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279 WE8ISOICLUK ICL special version ISO8859-1

351 WE8MACROMAN8 Mac Client 8-bit Extended Roman8 West European

352 WE8MACROMAN8S Mac Server 8-bit Extended Roman8 West European

353 TH8MACTHAI Mac Client 8-bit Latin/Thai

354 TH8MACTHAIS Mac Server 8-bit Latin/Thai

368 HU8CWI2 Hungarian 8-bit CWI-2

380 EL8PC437S IBM-PC Code Page 437 8-bit (Greek modification)

381 EL8EBCDIC875 EBCDIC Code Page 875 8-bit Greek

382 EL8PC737 IBM-PC Code Page 737 8-bit Greek/Latin

383 LT8PC772 IBM-PC Code Page 772 8-bit Lithuanian (Latin/Cyrillic)

384 LT8PC774 IBM-PC Code Page 774 8-bit Lithuanian (Latin)

385 EL8PC869 IBM-PC Code Page 869 8-bit Greek/Latin

386 EL8PC851 IBM-PC Code Page 851 8-bit Greek/Latin

390 CDN8PC863 IBM-PC Code Page 863 8-bit Canadian French

401 HU8ABMOD Hungarian 8-bit Special AB Mod

500 AR8ASMO8X ASMO Extended 708 8-bit Latin/Arabic

554 AR8NAFITHA711 Nafitha Enhanced 711 Server 8-bit Latin/Arabic

555 AR8SAKHR707 SAKHR 707 Server 8-bit Latin/Arabic

556 AR8MUSSAD768 Mussa’d Alarabi/2 768 Server 8-bit Latin/Arabic

557 AR8ADOS710 Arabic MS-DOS 710 Server 8-bit Latin/Arabic

558 AR8ADOS720 Arabic MS-DOS 720 Server 8-bit Latin/Arabic

559 AR8APTEC715 APTEC 715 Server 8-bit Latin/Arabic

560 AR8MSAWIN MS Windows Code Page 1256 8-Bit Latin/Arabic

560 AR8MSWIN1256 MS Windows Code Page 1256 8-Bit Latin/Arabic

561 AR8NAFITHA721 Nafitha International 721 Server 8-bit Latin/Arabic

563 AR8SAKHR706 SAKHR 706 Server 8-bit Latin/Arabic

565 AR8ARABICMAC Mac Client 8-bit Latin/Arabic

566 AR8ARABICMACS Mac Server 8-bit Latin/Arabic

ID Name Description
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590 LA8ISO6937 ISO 6937 8-bit Coded Character Set for Text 
Communication

797 US8NOOP No-op character set prohibiting conversions

829 JA16VMS JVMS 16-bit Japanese

830 JA16EUC EUC 16-bit Japanese

832 JA16SJIS Shift-JIS 16-bit Japanese

833 JA16DBCS IBM DBCS 16-bit Japanese

835 JA16EBCDIC930 IBM DBCS Code Page 290 16-bit Japanese

836 JA16MACSJIS Mac client Shift-JIS 16-bit Japanese

840 KO16KSC5601 KSC5601 16-bit Korean

842 KO16DBCS IBM DBCS 16-bit Korean

845 KO16KSCCS KSCCS 16-bit Korean

850 ZHS16CGB231280 CGB2313-80 16-bit Simplified Chinese

851 ZHS16MACCGB231280 Mac client CGB2313-80 16-bit Simplified Chinese

860 ZHT32EUC EUC 32-bit Traditional Chinese

861 ZHT32SOPS SOPS 32-bit Traditional Chinese

862 ZHT16DBT Taiwan Taxation 16-bit Traditional Chinese

863 ZHT32TRIS TRIS 32-bit Traditional Chinese

864 ZHT16DBCS IBM DBCS 16-bit Traditional Chinese

865 ZHT16BIG5 BIG5 16-bit Traditional Chinese

866 ZHT16CCDC HP CCDC 16-bit Traditional Chinese

870 AL24UTFFSS Unicode UTF-8

997 JA16TSTSET2 ASCII-based 16-bit Test Character Set

998 JA16TSTSET Shift-sensitive ASCII-based Test Character Set

ID Name Description
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A.4 Number Ranges for Express Data

A.4.1 Very large positive or negative numbers
Express can store extremely large positive or negative numbers. In most cases, these 
numbers can easily be displayed in Reports Developer. However, if the number is 
outside of a certain range, it cannot be displayed in Reports. An “out of range data 
error” message is displayed if an Express decimal number “x” is found in the 
following range:

x > 9.9999999999999999999999999999999999999 * 10^125

x < -9.9999999999999999999999999999999999999 * 10^125

A.4.2 Rounding very small numbers
Express can store extremely small decimal numbers, such as numbers less than zero 
with several hundred decimal places. In most cases, these numbers can easily be 
displayed in reports. You can use a setting to specify whether numbers outside of 
certain ranges are rounded up to zero and displayed as zero in reports or whether a 
“rounding data error” message is displayed. The setting affects an Express decimal 
number “x” in the following ranges:

-1 * 10^-125 < x <= -4.94065645841246544 * 10^-324

4.94065645841246544 * 10^-324 <= x < 1 * 10^-125

A.4.3 Specifying the rounding setting
To specify the setting for rounding, you must create or modify the xrb.ini file, so 
that the setting can take effect. The following procedure explains how to make the 
specification in the file.

1. On the computer where Oracle8 is running, look in the ORACLE_HOME\BIN 
directory for the xrb.ini file. If the file exists, go to Step 3. Otherwise, go to 
Step 2.

2. With a text editor, create the xrb.ini file in the ORACLE_HOME\BIN 
directory.

3. In a text editor, scroll to the [Options] section of the file, or create this section 
label if it does not exist.
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4. Edit the value of the ZeroSmallNumbers setting if it exists; otherwise, create the 
setting. Specify one of the following values:.

5. Save your changes and close the file.

A.4.4 Example setting for rounding
The following example shows a sample setting for the rounding setting.

[Options]
ZeroSmallNumbers = 0

A.5 Indents in Hierarchical Express Data
Express data may be stored in hierarchies, or levels. By default, hierarchies appear 
in reports with indents of two single-byte spaces. You may change the type of 
characters used to fill indents and the size of indents between levels of data by 
editing the xpdata.ini file 

1. On the machine where Oracle Reports Developer is running, open the ORACLE_
HOME\BIN\xpdata.ini file in the   directory.

2. If the file does not exist, using a text editor, create xpdata.ini.

3. Scroll to HierChar=. This setting is located in the [XRU] section of the file.

HierChar= defines the indent character as a single-byte space. You may edit 
this setting for any keystroke character(s), such as asterisk (*) or dash (-). When 
editing, use quote marks around the character of your choice:

HierChar="*"

Value Description

0 displays an error message rather than displaying very 
small numbers in reports

1 rounds the very small numbers up to zero and displays 
them in reports (Default)
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4. Scroll to HierIndent=2.

This setting may be any integer from 0 though 10. A value of 0 turns off 
indenting. Values of 1 through 10 specify the number of single-byte characters 
to include in the indent. The default setting is 2.

5. Save your changes and close the file.

A.5.1 Example settings for hierarchal data
Settings in the xpdata.ini file:

HierChar="+ "
HierIndent=4

The report output would be formatted as follows:

Great Brittain
+ + + + England
+ + + + + + + + London
+ + + + + + + + Salisbury
+ + + + Scotland
+ + + + + + + + Edinburgh
+ + + + + + + + Glasgow
United States
+ + + + California
+ + + + + + + + Los Angeles
+ + + + + + + + San Francisco
+ + + + + + + + San Jose
+ + + + Pennsylvania
+ + + + + + + + Philadelphia
+ + + + + + + + Pittsburgh
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